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Chapter 1

4.

10.

15c.

16.

23.

25.

29.

The knowledge software engineers have collected over time such as algorithms, and data structures.
It also includes programming methodologies such as object-oriented design and software concepts
such as information hiding, encapsulation, and abstraction. Finally, it can include tools such as
CRC cards and UML.

Use meaningful identifier names. Document each logical block of code, each loop, and each
subprogram. Include module reuse as a goal of your design process.

Understand the problem to be solved.

An aspirin is seen by a patient as a means for controlling headache pain. A chemist sees it as a
compound to be formulated.

The details of all the steps necessary to actually display text on the screen as are the details of
converting the binary representation of a floating point number to characters are hidden from the
user of the 1/0 operations.

Some attributes not relevant to cooking are color, shipping weight, self-cleaning capability, and
number of light bulbs.

Ada packages are written in two parts in order to separate what the package does from how it does
it.

Inheritance provides a powerful reuse tool that allows programmers to create a new class (subclass)
that is a specialization of an existing class (superclass). The subclass inherits the attributes and
operations of its superclass. We usually make a subclass more specialized by adding more
attributes and operations and changing (overriding) some of the superclass operations.
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35d and 36d
Cooking Utensil
Bakeware Cookware Measuring Cup
I |
Sautee Pan Sauce Pan
44. A programmer might assume that a user of the program enters large numbers without the commas

47a.

50.

55.

59.

63.

66a.

that are commonly used to make number easier to read. A comma may result in an unhandled
Data_Error exception.

Verifying a program without executing it.
Verifying a program by executing it with a set of test data.
A statement that is either true or false but not both. Also called a proposition.

The result of calling a subprogram when the precondition is False is not known. The program may
crash with a run-time error or continue in an invalid state that may not be evident for some time.

Sum = 0;
Index = 1;
loop

exit when Index > Max_List or else List(Index) = O;
Sum = Sum + List(Index);
end loop;

The loop displays all of the components of the array List. There are only 37 "good" values. We
need to use another variable whose value is equal to the number of good values in the array List and
use that variable in our loop rather than the maximum number of values List can hold.

Data coverage testing uses test cases based on the possible input values. Code coverage uses test
cased based on the branches or paths in the code.

The functional domain is the set of integers from 0 to 100.
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b. Yes, it would only require 101 test cases.

c. Using data coverage, create a test case for the lowest, middle, and highest scores for each of the
letter grade ranges.

69.
function Terminate Loop (Factor_1 : in Integer;
Factor_ 2 : in Integer) return Boolean is
begin
return Factor_1 = Factor_2;
end Terminate_Loop;

71a. The definition of Integer ensures that Value is a whole number.

b. The definition of Dozen ensures that Chicken is greater than zero.

Chapter 2

3. Adata structure is collection of elements. A data type may be a single element or multiple
elements. The logical organization of the elements in a data structure have a direct influence on the
accessing operations used to store or retrieve individual elements. Even when a data type has
multiple elements, their organization does not usually influence the storage and retrieval of
individual elements.

7. Atthe application level, a list of student academic records might be used to determine scholarship
recipients. At the abstract level, there may be operations to retrieve the record of the student with
the highest grade point average, to print a list of students in order by grade point average, to modify
a student's grade point average, etc. At the implementation level, the list might be implemented as
an array of records.

10. Modular types are not signed so we can store larger values. (For example, on a 32 bit processor, the
largest Integer is usually 2*'-1 while the largest modular type is usually 2°-1.) Modular types use
modular (clock) arithmetic. Finally, we can use the logical operators with modular types to
manipulate the bits comprising them.

14. Equality testing, assignment, relational testing (for array with discrete components), indexing,
slicing, and attributes ('First, 'Last, 'Length, 'Range).

17a. type Decade_Weather_Array is array (Month_Type, Year_Range) of Weather_Rec;
Decade Weather : Decade Weather_Array;

C. Decade_ Weather(March, 1989).Avg Lo Temp := 26;
21. The type from which the operations and values (domain) for a subtype are taken
22. The package.

25. Classes are stored in packages. A subclass is stored in a child package of its superclass's package.
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28.  An operation for a type that is declared in the same package specification as the type and has a
parameter or return value of the type.

30. So that the construction operations are not primitive operations. This ensures that a subclass does
not inherit any constructor operations from its superclass. Each subclass must define its own
constructors.

32a. The details of an ADO are encapsulated within the package body which is not accessible to the
application programmer.

c. By defining a private type and encapsulating the details within the private section of the package
specification. The private part of a package specification is not accessible to the application
programmer.

d. We can create many objects of the type.

e. We can create just one object of the type.

35. Constructors are used to create new values of a class. We cannot create an instance of an abstract
class and therefore we cannot make use of a constructor.

40a. It is easy to set and retrieve the real and imaginary parts of a complex number. We can construct
complex values any way we like.

b. A constructor operation and operations to retrieve the real and imaginary parts.

Chapter 3

la. type Month_Type is (Jan, Feb, Mar, Apr, May, Jun,

Jul, Aug, Sep, Oct, Nov, Dec);
package Month_Set is new Discrete_Set (Element _Type => Month_Type);
d. Winter_Months := Month_Set.Empty Set;
Winter_Months := Winter_Months + Nov + Dec + Jan;

4a. B := My Set.Universal _Set — A;

C. Tunction Complement (Set : in Set_Type) return Set _Type is
begin

return not Set;
end Complement;

7. ltis likely that creating an array of Booleans indexed by Integer required more memory than was
available.

10. package Precise Ops is new

Ada_-Numerics.Generic_Elementary Functions (Float_Type => High_Precision);
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12. procedure Sort is new Ada.Containers.Generic_Constrained Array_Sort
(Index_Type => Lowercase,
Element_Type => Natural,
Array_Type => Natural_Array,
<t => Standard.’<");

15a generic
type Value Type is (<>);
with function ">=" (Left in Value_Type;
Right in Value_Type) return Boolean;
function Largest (First : in Value Type;
Second : in Value_Type;
Third : in Value_Type) return Value_Type;

function Largest (First : in Value Type;
Second : in Value_Type;
Third : in Value_Type) return Value Type is
begin
if First >= Second then
if First >= Third then
return First;
else
return Third;
end if;
else
if Second >= Third then
return Second;
else
return Third;
end if;
end if;
end Largest;

Chapter 4
2. String
Fixed-Length Varying-Length
String String
Bounded- Unbounded-
Length String Length String
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5.

8 a.
C.
e.

10.

12 a.

13 a.

17.

subtype My String Type is String (1..45);

6
10
10

Call the functions Exists and Kind in package Ada.Directories.
with Ada.Directories; use Ada.Directories;

with Ada.Text 10; use Ada.Text 10;

procedure Demo is

subtype File_Name_String is String (1..80);

File Name : File_Name_String;
Length > Natural; -- Number of characters in File_Name
begin

Put_Line ("Enter a file name™);
Get _Line (Item => File_Name, Last => Length);

if Exists (File_Name(l..Length) ) then
Put Line ("The Ffile " &
File_Name(l..Length) &
exists and is type " &
File_Kind"Image (Kind (File_Name(l..Length))) );

else
Put Line ("The Ffile " &
File Name(l..Length) &
' does not exist'™);
end if;
end Demo;

package File Names is new Ada.Strings.Bounded.Generic_Bounded Length(100);

procedure Get_Line (Item : out File Names.Bounded String) is
Fixed_Item : String (1..File_Names.Max_ Length);
Length : Natural;

begin

Ada.Text _10.Get _Line (ltem => Fixed_ltem,
Last => Length);
Item = File_Names.To_Bounded_String (Fixed_Iltem (1..Length));
end Get_Line;

A better approach for reading a bounded length string is to instantiate a bounded-length string 1/0
package from Ada. Text_10.Bounded_1I0.

function Index (Source
Pattern

in Bounded String;
in Bounded _String) return Natural is
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22,

26 a.

30 a.

31c.

First : Positive; -— Pattern is compared to

Last Positive; - Source (First..Last)

begin -- Search
First := 1; -- Begin search at the first position of Source
Last := Pattern.Length;
Search_Loop: -- Each iteration, the pattern is compared to one slice
loop -- of the source

-- Exit when there are fewer characters remaining in Source to check
-- than there are in the Pattern or when match is found
exit when Last > Source.Length or else

Source.Data(First..Last) = Pattern.Data(l..Pattern.Length);
First := First + 1;

Last := Last + 1;

end loop Search_Loop;

if Last <= Source.Length then -— Did we find the pattern?
return First;

else
return O;

end if;

end Index;

Convert the bounded-length string to a fixed-length string (using the operation from package
Strings) and then to an unbounded-length string (using the operation from package
Ada.Strings.Unbounded).

return To_Unbounded_String (To_String(ltem));

6 bytes
Student_List.all(1).1D := 1000;

for Index in Student List.all’Range loop
Student_List.all(Index).Total Hours := Student List.all(Index).Total Hours
+ Student_List.all(Index).Current _Hours;
Student_List.all(Index).Current_Hours := 0;
end loop

Free (Student List);
After calling Free, Student_List contains the value nul .

Finalize is called for Oak.
The value of Mapl e is copied into Oak.
Adjust is called for Oak.

The declaration of EIm specifies an initial value so Initial ize is not called when EIm is
elaborated.
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Chapter 5

1.

4a.

6e.

10.

They are ordered so that the last item added to the stack is the first one removed (LIFO).

package Name_Stack is new Stack(Element_Type => Name_Rec);

Names : Name_Stack.Stack Type (Max_Size => 250);

package Name_Stack is new Unbounded_Stack(Element_Type => Name_Rec);

Target.Clear;
Temp.Clear;

loop
exit when Source.Empty;
Source.Pop (Value);
Temp.Push (Value);

end loop;

loop
exit when Temp.Empty;
Temp.Pop (Value);
Source.Push (Value);
Target.Push (Value);
end loop;

procedure Replace Element (Stack : in out Stack Type;
Old_El : in Element_Type;
New_El : in Element_Type) is

Temp : Stack Type (Max_Size => Stack.Max_Size);
Value : Element_Type;

begin
loop
exit when Stack.Empty;
Stack.Pop (Value);
if Value = OId_EI then

Value := New_EIl;
end if;
Temp.Push (Value);
end loop;

loop
exit when Temp.Empty;
Temp.Pop (Value);
Stack.Push (Value);
end loop;
end Replace Element;
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13

16 b.

19.

21 a.

22 a.

This program displays the numbers 1 through 5. The first loop of the program displays a random
subset of these numbers in ascending order. The second loop of the program displays the remaining
numbers, if any, in descending order.

This output sequence is possible. This output sequence occurs when all five of the calls to the
random Boolean generator return True so no values are displayed by the first loop. All five values
are pushed onto the stack and later displayed in reverse order.

This output sequence is not possible. The ascending order sequence 1, 3, 5 is followed by the
ascending order sequence 2 and 4.

type Stack Array is array (Positive range <>) of Integer;

type Double _Stack Type (Max_Size : Positive) is
record
Even_Top : Natural 0;
0dd _Top : Positive := Max _Size + 1;
Elements : Stack Array (1..Max Size);
end record;

procedure Cut_Back (Stack : in out Stack_Type;
By in Positive) is

begin

if By > Stack.Top then

raise UNDERFLOW;

end if;

Stack.Top := Stack.Top - By;
end Cut_Back;

Invalid. Assigning an integer to an access variable

Valid. Assigning an integer to the Info field in the node designated by Stack.

Valid. Leaving off the optional dereferencing operator .al l is poor style.

Pointer

Record.

. Array
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24 a.

25 a.

28.

The memory for all local variables is stored on the system stack (review the discussion on the
Organization of Memory on page 255 of the textbook). The memory used by these local variables
is recycled when control returns from the subprogram to the caller.

The memory for all local variables is recycled when control returns from the subprogram to the
caller.

The maintenance programmer is worried about the memory used for the stack nodes. Memory for
these nodes is allocated on the heap (review the discussion on the Organization of Memory on page
255 of the textbook). Since the unbounded stack type is a controlled type, procedure Finalize is
called automatically when First and Second go out of scope (just before the memory for these
local variables is removed from the system stack). Procedure Final ize is defined in the private
part of the unbounded stack package specification as another name for the Clear operation.
Clear recycles the memory used by all of the nodes in a stack.

Dynamically.

The space needed to store one access value.

procedure Cut Back (Stack : in out Stack Type;

By :in Positive) is
Current : Node Ptr; -- A local pointer used to count and to recycle nodes
Count : Natural; -- The number of nodes

begin
-— To check for UNDERFLOW we need to count the nodes in the stack
Count = 0;
Current := Stack.Top;
-- Go through the linked list to see if there are enough nodes
-- Each iteration, count one more node
loop
-— Exit when we reach the necessary count
- or we reach the end of the linked list
exit when Count = By or Current = null;

Count = Count + 1;
Current := Current.all_Next;
end loop;

if Count < By then
raise UNDERFLOW;
end if;

-- Remove the first By nodes from the stack
for Count in 1..By loop
Current := Stack.Top;
Stack.Top := Stack.Top.all_Next;
Free (Current);
end loop;
end Cut_Back;

10
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31. Because both white box testing and McCabe's complexity are based on the number of possible paths
through an algorithm.

34. The calculation of the square root is the "elephant™ within the loop. The exit statement and the
other two assignment statements are "goldfish".

36a. O(N?

d. O(N?

f. O(N?)
37b. O(1)

d. O(log;N)

40. All three of the statements are False.

Chapter 6
2a. 5

>

0

4 a. package Name Queue is new Stack(Element_Type => Name_Rec);

b. Names : Name Queue.Queue Type (Max_Size => 250);

5.  The call to Dequeue has a syntax error that would be caught by the compiler. The actual
parameter for the formal out mode parameter I'tem must be a variable, not an expression.

7a. loop
exit when My Queue.Empty;
My Queue.Dequeue (Last);
end loop;

11



Chapter 6 Answers to Selected Exercises

10

This program displays the numbers 1 through 5. The first loop of the program displays a random
subset of these numbers in ascending order. The second loop of the program displays the remaining
numbers, if any, in ascending order.

This output sequence is not possible because there is no way to partition this list into two lists each
in ascending order

This output sequence is possible. The ascending order sequence 1, 3, 5 is followed by the
ascending order sequence 2 and 4.

12 a. We have to first determine which queue in the array of ten queues the new job should be placed.

14.

The index of the correct queue may be calculated by dividing the ID by 100.

. procedure Clean_Up_Jobs (Jobs : in out Job_Array) is

Job : Job_Token;
begin
-— Clean up all the jobs
-- Each iteration, clean up one queue of jobs
for Index in Jobs®"Range loop

-— Clean up one queue of jobs

-— Each iteration, clean up one job

loop
exit when Jobs(Index).Empty;
Jobs(Index) .Dequeue (Job);
Notify (User => Job);

end loop;

end loop;
end Clean_Up_Jobs;

51 /7 14 = 3
51 rem 14 = 9
51 mod 14 = 9
-51 /7 14 = -3
-51 rem 14 = -9
-51 mod 14 = 5
51 /7 -14 = -3
51 rem -14 = 9
51 mod -14 = -5
-51 /7 -14 = 3
-51 rem -14 = -9
-51 mod -14 = -9

12
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16. function "=" (Left : in Queue_Type;
Right : in Queue_Type) return Boolean is
Left _Index : Positive;
Right_Index : Positive;
begin
if Left.Count /= Right.Count then
return False;
else -- we need to compare the elements
Left _Index := Left.Front;
Right_Index := Right.Front;
-— Compare all the elements in the two queues
-- Each iteration, compare one pair of elements
for Count in 1.._Left_Count loop
if Left.ltems(Left_Index) /= Right.ltems(Right_Index) then
return False;

end if;
Left _Index := Left Index rem Left.Max Size + 1;
Right_Index := Right _Index rem Right_Max_ Size + 1;
end loop;
return True;
end if;
end "=";end Replace Element;

18. function Size (Queue : in Queue_Type) return Natural is

begin
return Queue.Count;
end Size;
21b. 5 16 27
23. function =" (Left : in Queue_Type;
Right : in Queue_Type) return Boolean is
Left Ptr : Node_ Ptr;
Right Ptr : Node Ptr;
begin
Left Ptr := Left.Front;

Right_Ptr :-= Right.Front;
-— Compare all the elements in queues
-— Each iteration, compare one pair of elements
loop
exit when Left Ptr = null or Right Ptr = null;
if Left Ptr.all_Info /= Right_Ptr.all._.Info then
return False;

end if;

Left Ptr := Left Ptr.all.Next;

Right_Ptr :-= Right_Ptr._.all _Next;
end loop;

-— If we reach this point, all of the elements compared were equal.
-— The queues are equal only if we have compared all the elements in both
return Left Ptr = null and Right Ptr = null;

end "=";

13
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26. function Size (Queue : in Queue_Type) return Natural is
Current : Node Ptr;

Count : Natural;
begin

Current := Queue.Front;

Count = 0;

—-— Count the nodes in the linked list
-- Each iteration, count one node
loop
exit when Current = null;
Count := Count + 1;
Current := Current.all_Next;
end loop;
return Count;
end Size;

Chapter 7

2 a. Name and address.
h. Name and year of award.

J. Inthe United States, each doctor has a Unique Physician Identification Number (UPIN). This
number is being replaced by the National Provider Identifier (NPI).

5a. They are all ordered sequences of elements. Lists are ordered by key while stacks and queues are
ordered by the time of insertion.

b. The more general names Insert and Delete are used rather than the specific names Push, Pop,
Enqueue, and Dequeue. These more general names reflect the ability to insert and delete any item
in the collection rather than items in specific locations in the sequence.

c. The list is the more general class. Stacks and queues are more specialized lists.

8. By changing the mode from in out to in, we can eliminate the precondition that the Process
procedure not change the key of an element. Also, most process procedures do not change elements
in the list. Forcing the use of in out mode for such process procedures is poor style. The advantage
of using in out mode is that process procedures can modify all the elements in the list.

10. Because many friends live in the same zip code, we cannot create a list with zip code as the key.
Our approach is to create a unique key by combining the zip code and name.

14
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type Zip_Rec is
record
Zip : Zip_String;
Name : Name_Rec;
end record;

function Zip_OFf (Friend : in Friend_Rec) return Zip_Rec is
Result - Zip_Rec;

begin
Result.Zip := Friend.Address.Zip;
Result.Name := Friend.Name;
Return Result;

end Zip_OfF;

function "<" (Left : iIn Zip_Rec; Right : in Zip_Rec) return Boolean is
begin
if Left_Zip = Right_Zip then
return Left_Name < Right_Name;
else
return Left.Zip < Right.Zip;
end if;
end "'<";

package Zip_List is new Key Ordered List (Element Type => Friend_Rec,

Key Type => Zip_Rec,
Key OF => Zip_Of,
e => ":",

ll<ll :> ll<ll -

procedure Labels (File Name : iIn String) is

Label File : Ada.Text_ 10.File_Type;
Friends : Zip_List_List Type(Max_Size => The_Book.Length);

-— Local procedure for putting one friend into a zip ordered list
procedure Insert _One Friend (Friend : in out Friend_Rec) is
begin
Friends.Insert(Friend);
end Insert _One Friend;

-- Local procedure for printing one label
procedure Put_One Label (Friend : in out Friend_Rec) is
begin
Put _Line (File => Label File,
Item => To_String(Friend.Name.First) & " " &
To_String(Friend.Name.Last));
Put _Line (File => Label _File,
Item => To_String(Friend.Address.Street));
Put _Line (File => Label File,
Item => To_String(Friend.Address.City) & ", " &
Friend.Address.State & * 7);
Put Digits (File => Label File,
Item => Friend.Address.Zip);
New_Line(File => Label_File, Spacing => 2);
end Put_One_ Label;

15
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12 a.

15a.

18 a.

begin
-— Copy the book into a zip ordered list
The_Book.Traverse (Insert_One Friend"Access);
Ada.Text_10.Create (File => Label File,

Name => File_Name);

Friends.Traverse (Put_One Label"Access);
Ada.Text_10.Close (Label _File);

end Labels;

In a sequential list, the elements the elements are physically ordered. So given the address of one
element we can calculate the address of the next element in the list. With a linked list, the elements
have no physical order. We have to use the link to locate the next element in the list.

. We can search sequential lists faster than we can search linked lists. So any application where list

observer operations are more common than adding and deleting elements would be better
implemented with a sequential list.

Linked lists eliminate the need to move large numbers of elements required to insert or delete in a
sequential list. So any application with a high frequency of adding and deleting elements would be
better implemented with a linked list.

True (if you consider elaboration to be a form of dynamic memory allocation)
False (if you restrict dynamic memory allocation to memory obtained through the new operator)

True
False (all access variables have an initial value of null)
True

True

False (Ptr uses the memory of a single access value while One_Node uses the memory needed for
an element plus an access value)

. False (Node_Type is arecord. We can use Node_Type as with any record type)

Valid

Invalid, assigning a record to an access variable

16
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c. Invalid, assigning an access value to a record variable
d. Invalid, assigning an element type to an access variable
e. Valid

f. Valid

g. Valid syntax, however with the linked list shown on page 468 it dereferences a null pointer.

21. 20
10

24. 4
1
3
5
2
4

26 a. procedure Traverse
(List : In out List _Type;
Process : not null access procedure (Element : in out Element _Type));

-— Purpose : To process all the elements in List in ascending order
-- Preconditions : None

-- Postconditions : Every element in List is passed to a call of

- procedure Process

- Elements processed in ascending order

-- Exceptions : KEY_ERROR raised when Process changes the key of Element

b. procedure Traverse
(List in out List Type;
Process : not null access procedure (Element : in out Element_Type)) is

Current_Element : Element_Type;

begin
for Index in 1.._List_.Length loop
Current_Element := List.ltems(Index); -- Make a copy of the element
Process (Current _Element); -- Call user®s procedure to process the copy
if Key OF (Current_Element) = Key Of (List.ltems(Index)) then
List.Items(Index) := Current_Element; -- Put the element back into list
else
raise KEY_ERROR; -- Process changed the key
end if;
end loop;

end Traverse;

17
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c. Any list elements processed before KEY_ERROR is raised may be changed.
-- Exceptions - KEY_ERROR raised when Process changes the key of Element

-— Any elements processed before the exception is raised
- may be changed by this procedure

28. Function Size is identical to function Length which was already included in both packages

d. Sizeis O(1) for the array based key ordered list and O(N) for the linked-list based key ordered list.

31 a. procedure Get_Element (List : in List_Type;
Position : in Positive;
Element : out Element_Type);

-- Purpose . Retrieves the element at the given Position
-- Preconditions : None
-— Postconditions : Element is a copy of the element at the given Position
-- Exceptions > CONSTRAINT_ERROR raised if Position > List.Length
C. procedure Get _Element (List > In List _Type;

Position : Iin Positive;
Element : out Element _Type) is
Current : Node Ptr;

begin
Current := List.Head; -- Set Current to designate first element
for Count in 2._Position loop -— Move Current to the Position element
Current := Current.all_Next;
end loop;
Element := Current.all.Info;

end Get Element;

When Position > List.Length, the above procedure raises CONSTRAINT_ERROR because Current
runs off the end of the linked list and the procedure attempts to deference a null pointer.

d. Get_Element is O(1) for the array based key ordered list and O(N) for the linked-list based key
ordered list.

18
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32 c. procedure Reverse_Traverse

(List : In out List _Type;

Process : not null access procedure (Element :

Answers to Selected Exercises

in out Element_Type));

package Ptr_Stack is new Stack (Element_Type => Node Ptr);

Stack : Ptr_Stack.Stack Type(Max_Size => Length(List));
Location : Node Ptr;

begin
Location := List._Head;

-— Traverse the linked list pushing pointers to each

of the nodes

in the list onto the stack

-- Each iteration, push one pointer onto the stack

loop
exit when Location = null;
Stack.Push (Location);
Location := Location.all_Next;
end loop;

-- Process all of the list elements

in reverse order

-- Each iteration, one list element is processed

loop
exit when Stack.Empty;
Stack.Pop (Location);
Process (Location.all.Info);
end loop;

end Reverse_Traverse;

Chapter 8
2a. O(N)
b. Twice
5. Insert at both the front and rear of the list is O(1).

9a.

procedure Get Element (List > In List Type;
Position : in Positive;
Element : out Element_Type);
—-— Purpose : Retrieves the element at the given Position
-- Preconditions : None
-— Postconditions : Element is a copy of the element at the given Position
-- Exceptions > CONSTRAINT_ERROR raised if Position > List.Length

19



Chapter 8
b. procedure Get_Element (List :in
Position : in
Element : out
Current : Node Ptr;
begin

Current := List.Tail.all_.Next;
for Count in 2._.Position loop
Current := Current.all .Next;
if Current = List.Tail.all_Next
raise CONSTRAINT_ ERROR;
end if;
end loop;
Element := Current.all.Info;
end Get _Element;

Get_Element is O(N).

12.

15.

Answers to Selected Exercises

List _Type;
Positive;
Element_Type) is

Set Current to designate first element
Move Current to the Position element

then
we wrapped around

More storage is used for pointers. Algorithms are more complex.

It cannot be done in O(1). We need to change the Next field of the predecessor of the last node.

We cannot get directly to the predecessor of the last node. We must start at the first and work our
way through the linked list to get to the predecessor of the last node.

18 a. procedure Split_List (Main_List
Split_Key
List_1
List_2

Boolean;

Node Ptr;

Found :
Location :
begin
Search_Circular_List (List
Key
Found =>
Location =>
-- Change pointers to set up List 1
List_1._Tail
List_1.Tail.all_Next

=>
=>

out List Type;

Key Type;

out List Type;
out List _Type)

Main_List,
Split_Key,
Found,

Location);

:= Location.all _.Back;
= Main_List.Tail.all_Next;

List 1.Tail.all_Next.all.Back := List_1.Tail;

-- Change pointers to set up List 2

List 2.Tail

List 2_.Tail.all_Next :=

Location.all _.Back

-— "Empty" Main_List

Main_List.Tail := null;
end Split_List;

Location;

= Main_List.Tail;

= Main_List.Tail;

21 a. The special case of adding a node at the beginning of the list (where the external pointer is

changed).

20
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b. The condition checking for a null pointer in the exit statement of the search loop.

c. No. Push and pop both change the external pointer. Changing the external pointer is not a special
case.

d.No. Enqueue and dequeue both change external pointes. Changing an external pointer is not a
special case.

e. No. Enqueue and dequeue both change external pointes. Changing an external pointer is not a
special case.

23 a. Horace and Mildred probably used a dummy node with a key less than Zzuan.

b. By using a name made up of the characters Character'Last.

26. In this data structure, an empty list consists of two nodes—a header node and a trailer node. We
override procedure Initialize to create these two dummy nodes.

30 b. procedure Get_Element (List : in List_Type;
Position : In Positive;
Element : out Element _Type) is
Current : Node Ptr;

begin
Current := List.Head.all_.Next; -- Set Current to designate first element
for Count in 2._Position loop -— Move Current to the Position element
Current := Current.all_Next;
end loop;

if Current.all.Info = Max _Element then
raise CONSTRAINT_ERROR;
end if;
Element := Current.all.Info;
end Get_Element;

When Position > List.Length, the above procedure raises CONSTRAINT_ERROR because Current
runs off the end of the linked list and the procedure attempts to deference a null pointer.

33 a. Doubly linked. We need to access the predecessors and successors of a node

b. Circular. Gives us O(1) insert at the end of the list.

c. Header and trailer nodes. Eliminates the special cases for adding to and deleting from an empty list.
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36 a. John
Nell
Susan
Suzanne

b. David
Naomi
Robert

O = 00

d. Free is changed from 8 to 10. Here is what the array looks like.

Nodes .Info .Next
Miriam 9
Naomi
David
John
Robert
Susan
Suzanne
Joshua
Leah
Nell

QWO ~NOoO O, WN -
0O |IRO|INOO|IN|OT

[EE

e. Free is changed from 8 to 1. Here is what the array looks like.

Nodes .Info .Next
1 Miriam 9
2 Naomi 5
3 David 2
4 John 10
5 Robert 8
6 Susan 7
7| Suzanne 0
8 Tracy 0
9 Leah 0
10 Nell 6
39. 0(1)
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40. The Size function returns the number of elements in the file. Deleting an element from the file-
based list does not reduce the size of the file. Our memory management logic only extends the size
of the file when there are no unused locations in the file.

Chapter 9

la. A non-recursive solution for a trivial case of the problem being solved.

b. A combination of steps involving one or more recursive calls to solve smaller cases of the original
problem.

c. A subprogram calling itself.

d. A subprogram that calls another subprogram that eventually calls the original subprogram to solve a
smaller case of the original problem.

4 a. There are two base cases: Base > LimitandBase = Limit

b. Result := Base * Puzzle (Base + 1, Limit);
6a. type Num _Type is range Integer"First .. O;
9a. A postfix expression contains two operands.

An operand may be a postfix expression

b. The operands of a postfix expression are integers.

12 a. The parameters must not be negative.
subtype Float Type is Float range 0.0 .. Float"Last;

b. function Sqrt (Num . in Float_Type;

Approx : in Float_Type;
Tol : in Float_Type) return Float_Type is
begin
if abs (Approx ** 2 - Num) <= Tol then
return Approx;

else
return Sgrt (Num => Num,
Approx => (Approx ** 2 + Num) / (2.0 * Approx),
Tol => Tol);
end if;
end Sqrt;
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15. procedure Traverse (List : in List_Type) is
-- Traverses List in order.

begin
if List = null then
null; —- list is empty (do nothing) -- Base case
else
Process (Element => List.all.Info); -- General
Traverse (List => List.all_Next); -- Case
end if;

end Traverse;

Reverse_Traverse is a much better use of recursion. Traverse could be done as easily with
iteration.

18 a. A data structure that keeps track of activation records during the execution of a program.

b. The point in the compile-link-execution cycle when variable names are associated with addresses in
memory.

c. The case where a recursive subprogram contains a single recursive call that is the last statement
executed in the subprogram.

d. The association of a memory address with a variable name.

21. With dynamic storage allocation, variables are not bound to actual addresses in memory until run
time. With recursion, parameters and local variables are assigned actual addresses (on the run-time
stack) with each recursive call.

24. The base cases are

We have already escaped from the maze
The current position is the exit
The current position is a trap

The current position has already been tried

24
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Chapter 10

la. The maximum search time is proportional to the number of levels in the tree.

b. 100

4, N ancestors

SRETE TRy

10 a. False
b. True

c. False

13. Procedure Find changes the state of the binary search tree. It changes which node is designated as
the current node.

17.  Modify and Retrieve raise CURRENT_UNDEFINED when the current element is not defined.

20. procedure Greatest_Frequency (Tree : In out Freq_Tree.Tree_Type;
Result : out Natural) 1is

-- This local procedure uses the local global parameter Result
procedure Check_One Word (Word : in out Freg_Rec) is
begin
if Word.Freq > Result then
Result := Word.Freq;
end if;
end Check One Word;

begin
Result := 0;
Tree.Traverse (Order => Inorder,

Process => Check One_Word="Access);
end Greatest_Frequency;
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23 ¢. We need to create and display a list of women students ordered by GPA. We can use a binary
search tree to implement such a list. Because there may be duplicate GPASs in the list, we cannot
create a tree with GPA as the key. Our approach is to create a unique key by combining the GPA
and ID number.

type GPA Rec is

record
GPA : GPA_Type;
1D : Positive;

end record;

function GPA OF (Student : in Student Rec) return GPA _Rec is
Result : GPA Rec;

begin
Result.GPA := Student.GPA;
Result.ID := Student.ID Num;
return Result;

end GPA Of;

function ">" (Left : in GPA_Rec; Right : in GPA_Rec) return Boolean is
begin
if Left.GPA = Right.GPA then
return Left_ID > Right.ID;
else
return Left.GPA > Right.GPA;
end if;
end '>";

package GPA Tree is new Binary_Search_Tree
(Element_Type => Student_Rec,

Key Type => GPA_Rec,
Key OF => GPA_OfF,
et => ">",

Rt => ":") ;

procedure Women By GPA (Tree : in out Student Tree.Tree_Type) is
-- Contains two nested procedures
Women : GPA _Tree.Tree_Type;

procedure Insert _One Woman (Student : in out Student_Rec) is
begin
if Student.Sex = Female then
Women. Insert(Student);
end if;
end Insert_One_ Woman;

procedure Put_One_ Student (Student : in out Student Rec) is
begin
Put (Student.First Name & " " & Student.Last Name);
Put (Item => Student.GPA, Fore => 2, Aft => 2, Exp =>0);
Put (Item => Student.I1D_Num, Width => 8);
New_Line;
end Put_One_Student;
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begin -- procedure Women_ By GPA
-— Insert all of the women into a tree ordered by GPA
Tree.Traverse (Order => Student _Tree.Preorder,
Process => Insert_One_Woman®Access);
-— Display all of the women in order by GPA
Women.Traverse (Order => GPA Tree.lInorder,
Process => Put_One_Student®access);
end Women_By GPA;

26.

29. False

32 a. O(logoN) Mathematical note: The expected height of a binary search tree made by inserting keys
in random order is 1.39 logzN, about 40% taller than the minimum height tree.

b. O(N)

35 a.procedure Ancestors
(Tree : in Tree_Type;
Key : 1n Key_ Type;
Process : not null access procedure (Element : in out Element_Type)) is
Current : Node Ptr;
begin
Current := Tree.Root;
loop
exit when Current = null;
Process (Current.all.Info);
if Key < Key OFf (Current.all.Info) then

Current := Current.all._Left;
else
Current := Current.all_Right;
end if;
end loop;

end Ancestors;
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b. Instead of calling the procedure Process each time through the loop, push a copy of Current onto a
stack. Add a second loop that pops the pointers off of the stack and processes the nodes. See the
solution to Exercise 32c in Chapter 7 for code that you can modify to implement this algorithm.

C.procedure Ancestors
(Tree : in Tree_Type;
Key : iIn Key_ Type;
Process : not null access procedure (Element : in out Element _Type)) is

procedure Recursive_Ancestors (Root : Node Ptr) is
begin
if Root /7= null then
-- Process all of the descendants before the root
if Key < Key OFf (Root.all.Info) then
Recursive_Ancestors (Root => Root.all._Left);
else
Recursive_Ancestors (Root => Root.all.Right);
end if;
Process (Root.all.Info);
end if;
end Recursive_ Ancestors;
begin
Recursive_Ancestors (Root => Tree.Root);
end Ancestors;

38. procedure Copy (Source : in Tree_Type;
Target : out Tree_Type) is

function Copy (Root: in Node Ptr) return Node Ptr is
-- Recursive local function
begin
if Root = null then
return null;
else
return new Node Type®"(Info => Root.all.Info,
Left => Copy (Root => Root.all_Left),
Right => Copy (Root => Root.all_Right));
end if;
end Copy;

begin
Target.Root
Target.Current :
end Copy;

Copy (Source.Root);
null;

41 a. Only the tree in figure (e) satisfies the binary search tree property.

b. The trees in figures (b), (d), and (e) are complete binary trees.

c. The trees in figures (b) and (e) are complete binary trees.
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44 a. True. The internal nodes are those stored in locations 1 through 42. 42 is the index of the last
internal node as it is the parent of the last leaf node (index 85).

b. False. The children of the node at index 42 are at indices 84 and 85. Since the last index in the tree
is 85, the node at index 42 has two children.

c. False. The right child of Tree(13) is Tree(27).

d. True. By drawing a picture the subtree rooted at Tree(8) we see that the leaf nodes have indices 64
to 71. All of these nodes are in the original tree.

e. False. Draw the leftmost and rightmost branches of the tree. The leaf at the end of the leftmost
branch, Tree(64), is at the 7" level. The leaf at the end of the rightmost branch, Tree(63), is at the
6" level. Therefore the tree has 6 perfect levels and one additional level that contains some
elements.

Chapter 11

2. Someone with many items may wait for a very long time as people with fewer items keep coming
and getting in front of them.

4 b. subtype Name_String is String (1..20);
type GPA_ Type is digits 4 range 0.0..4.0;

type Student_Rec is

record
Name : Name_String;
GPA : GPA_Type;

Missed : Natural;
end record;

function Missed Days (Student : in Student Rec) return Natural is
begin

return Student._Missed;
end Missed_Days;

package Student_Queue is new Priority Queue
(Element_Type => Student Rec,
Priority_Type => Natural,
Priority OF => Missed_Days,
> => Standard."<");
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6 a. The item is the most recent time stamp. This is the item having the largest time value.

b. The instantiation would go in the private part of the stack specification as follows
private

type Time_Stamped_Element is

record
Element : Element_Type; -- The stack element type
Time : Ada.Calendar.Time;

end record;

function Priority OFf (Element : in Time_Stamped_Element)
return Ada.Calendar.Time;

package Stack Priority Queue is new
Priority Queue (Element_Type => Time_Stamped_Element,
Priority Type => Ada.Calendar.Time,
Priority OF => Priority Of,
> => Ada.Calendar.'>");

type Stack Type (Max_Size : Natural) is tagged limited
record
PQ : Stack Priority Queue.Queue_Type(Max_Size);
end record;

end Stack;
C.
procedure Push (Stack : in out Stack Type;
New_Element : in Element_Type) is

Stamped_Element : Time_Stamped Element;

begin
Stamped_Element.Element := New_Element;
Stamped_Element.Time := Ada.Calendar.Clock;
Stack.PQ.Enqueue (Stamped_Element);

end Push;

procedure Pop (Stack : In out Stack Type;

Popped_Element : out Element _Type) is

Stamped_Element : Time_Stamped Element;

begin

Stack.PQ.Dequeue (Stamped_Element);
Popped Element := Stamped_Element.Element;
end Pop;

d. Push and pop are both O(1) for the array based stack described in Chapter 5. As they simply call

the enqueue and dequeue operations, push and pop are both O(logzN) for this priority queue based
stack.
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e. No. The priority queue implementation of the stack has a poorer Big-O. It may also produce
incorrect results. If the clock ticks slower than the programs pushes items we may push multiple
items onto the stack with the same time stamps.

9a. private

type Node_ Type;
type Node Ptr is access Node Type;
type Node_ Type is
record
Info : Element_Type;
Left : Node Ptr;
Right : Node Ptr;
end record;

type Queue Type is new Ada.Finalization.Limited Controlled with
record
Root : Node Ptr; -- Designates first node in the tree
end record;

overriding procedure Finalize (Queue: in out Queue Type) renames Clear;

end Priority Tree;

b. procedure Enqueue (Queue : in out Queue Type;
Item : in Element_Type) is

procedure Insert (Root : in out Node Ptr) is
begin
if Root = null then
Root := new Node Type*(ltem, null, null);
elsif Priority_Of (Item) > Priority OFf (Root.all.Info) then
Insert (Root.all_Right);

else
Insert (Root.all.Left);
end if;
end Insert;
begin
Insert (Queue.Root);
exception

when STORAGE_ERROR =>
raise OVERFLOW;
end Enqueue;
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C. procedure Dequeue (Queue : in out Queue_Type;
Item : out Element _Type) is
Parent : Node Ptr;
Child : Node Ptr;
begin

if Queue.Root = null then

raise UNDERFLOW;
end i1f;

-- The node with the highest priority is at the
-- end of the tree"s right branch
Child := Queue.Root;

loop
exit when Child.all_Right = null;
Parent := Child;
Child := Child.all_Right;

end loop;

Item = Child.all.Info;

-- Remove the node from the tree
if Parent = null then

Queue.Root := Queue.Root.all.Left;
else

Parent_.all _Right := Child.all_Left;
end if;

Free (Child);
end Dequeue;

d. The Big-O depends on the height of the binary tree. The operations are O(log,N) for complete trees
and O(N) for degenerate trees.

12.  Any binary search tree in which there are no right children.

15. By supplying a less than operator as the actual generic parameter for the heap's generic formal
parameter ">".

18. Position 8 can contain any letter less than or equal to 'E".
Position 9 can contain any letter less than or equal to 'E".
Position 10 can contain any letter less than or equal to 'B'.

21 a. package Word_Strings is new Ada.Strings.Bounded.Generic_Bounded Length (50);

b. package Word Queue is new Priority Queue
(Element_Type => Word_Strings.Bounded_String,
Priority Type => Natural,
Priority OF => Word_Strings.Length,
> => Standard.">");
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24 a. V (State Graph) = {Oregon, Alaska, Texax, Hawaii, Vermont, New York, California}

27.

29.

E (State Graph_ = {(Alaska, Oregon), (Hawaii, Alaska), (Hawaii, Texas), (Hawaii, New York),
(Hawaii, California), (Texas, Hawaii), (Texas, Vermont), (Vermont, Alaska),
(Vermont, New York)}

. No.
. Yes
. Texas

M @ B & OB (® O
(1) | Alaska QO F ] F]IF]T]F]FI]F
(2) | California @ F F F F F F F
(3) | Hawaii | T| T|F|F|T]|T]|F
(4) | Oregon 4| F F F F F F F
(5) | New York G| F| F|F|F|F|F]|F
(6) | Texas 6)| F F T F F F T
(7) | Vermont ML T T F F T F F
Washington  Atlanta Denver (Atlanta taking off)
Washington  Atlanta
Washington
queue empty (Washington taking off)
Operation Big-O
Index_Of O(N)
Clear 0D
Add_Vertex O(N)
Add_Edge O(N)
Retrieve O(N)
Weight_Of O(N)
Get_Adjacent_Vertices O(N)
Clear_All_Marks O(N)
Mark_Vertex O(N)
Marked O(N)
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32. procedure Delete Edge (Graph : in out Graph_Type;

Edge : in Edge Type) is
From_Index : Positive;
To_Index : Positive;
begin
From_Index := Index Of (Graph, Edge.From); -- Location of From vertex
To_Index := Index Of (Graph, Edge.To); -- Location of To vertex

-- Do both vertices exist?

if From_Index > Graph_Num_Vertices or To_lIndex > Graph_Num_Vertices then
raise VERTEX_ ERROR;

-- Is the edge defined in the graph?

elsiT not Graph.Edges(From_Index, To_ Index).Defined then
raise EDGE_ERROR;

else
-- Remove the edge from the adjacency matrix
Graph.Edges(From_Index, To_Index).Defined := False;

end if;

end Delete_ Edge;

procedure Delete Vertex (Graph : in out Graph_Type;

Key : in Key Type) is
Index : Positive;
begin
Index := Index OF (Graph, Key);
if Index > Graph_.Num_Vertices then -- Is Key in the Graph?
raise VERTEX ERROR;
end if;
-- Remove the node from the vertex array and edge matrix
for Row in Index .. Graph_Num Vertices - 1 loop

-- Shuffle one vertex up
Graph.Vertices(Row) := Graph.Vertices(Row + 1);
-- Shuffle one row of the edge matrix up
for Column in 1..Graph_Num_Vertices loop
Graph_Edges(Row, Column) := Graph.Edges(Row + 1, Column);

end loop;

end loop;

Graph.Num_Vertices := Graph.Num_Vertices - 1;

end Delete Vertex;
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36. private

type Vertex Node;
type Edge_Node;

type Vertex Node Ptr is access Vertex Node;
type Edge Node Ptr is access Edge Node;

type Vertex_ Node is

record
Info : Vertex_Type; -- Information declared by user
Marked : Boolean := False; -- Has the Vertex been visited?
Edges : Edge_Node Ptr; -- Pointer to first edge in list
Next : Vertex_Node Ptr; -- Link to next vertex

end record;

type Edge Node is

record
Weight : Weight_Type; -- Weight assigned to the edge
Defined : Boolean := False; -- Is this edge in the graph?
Next : Edge_Node Ptr; -- Link to next edge

end record;

type Graph_Type is new Ada.Finalization.Limited _Controlled with
record
Head : Vertex_ Node Ptr;
end record;

overriding procedure Finalize (Graph : in out Graph_Type) renames Clear;

end Digraph;

Chapter 12

la. type Float_Array is array (Positive range <>) of Float;
procedure Sort Floats is new Sort (Element Type => Float,
Array_Type => Float_Array,
<t => Standard."<");

b. type Float_Array is array (Positive range <>) of Float;
procedure Sort Floats is new Sort (Element Type => Float,
Array_Type => Float_Array,
e => Standard.">");

4.  The selection sort is always O(N?)

7. Additional time is required to set and check the sorted flag.
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9a. O(N?
b. O(N)
c. ON%
d. O(N%

12.  The number of iterations of the outer loop is independent of the number of integers in the array
being sorted so it is O(1). The number of iterations of the inner loop is equal to the number of
integers in the array so it is O(N). The nesting is therefore O(N).

15. Base case a list of zero or one element is already sorted.
Smaller caller each recursive call is made with a list half the size of the original.
General case  when we merge two sorted lists, the result is a sorted list

18 a. False
b. True
c. False
d. False

21 a. So we don't compare the split value to itself

b. Left can exceed Values'Last which would raise CONSTRAINT_ERROR when using Left to index
the array Values. Right will never be less that VValue'First as the pivot element at that location.

24. Dbegin

if Values®Length > Limit then
Split (Values, Split_Index);
Quick _Sort (Values(Values"First .. Split _Index - 1));
Quick Sort (Values(Split Index + 1 .. Values"Last));

else
Insert_Sort (Values);

end if;

end Quick_Sort;

27 a. O(NlogzN)
b. O(N?)

c. O(NlogzN)
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30 a. True Merge sort requires twice the storage as it uses two arrays each of whose length is equal to the
number of elements being sorted. Heap sort uses a single array for the elements.

b. False Quick sort (using the first element as the split value) is O(N?) for nearly sorted data while
heap sort is O(Nlog,N) for all data.

c. True The execution times of the for loops of the heap sort are independent of data order.

33a. N=3
b.N=9
c.N=5

37. Anunstable sort is one in which the order of two equal keys is maintained. The reheap down
algorithm may reverse the original order.

39 a. False
b. True
c. False
d. True

42a &b.
Students : Student_List (Max_Size => Max_Students);
type Pointer_Array is array (Positive range <>) of Positive;

function "<" (Left : in Name_Type; Right : in Name Type) return boolean is
begin
if Left.Last Name < Right.Last Name then
return True;
elsit Left.Last Name > Right.Last Name then
return False;
else
return Left_First _Name < Right.First_Name;
end if;
end "'<";
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function Less _Then (Left : in Positive; Right : in Positive) return boolean is
-- This function accesses the global variable Students
begin
return Students.Students(Left).Student_Name <
Students.Students(Right) .Student_Name;
end Less Then;

procedure Sort_Pointers is new Quick _Sort (Element_Type => Positive,
Array_Type => Pointer_Array,

procedure Initialize (ltem

begin

for Index in Item®"Range loop

Item (Index) :=

Index;

ll<ll

: out Pointer_Array) is

=> Less_Then);

end loop;
end Initialize;

By Name : Pointer_Array (1..-Max_Students);

. Sort_Pointers (Values => By Name(l..Students.Num_Students));

45. 0(1)

48 a. 50
b.50
c.50

51a.
285 ] 153 177 | 140 66 |47 |87 | 126|145 90 | 393 | 395 | 467
@ @O @ 6 @ &6 ©® 0O © © W (1) (112 (1) W @5 (1. @ 1’
b.
2851 153 | 395 177 ] 140 66 87 |47 1393190 | 126 467 | 145
@O O @ & @ 6 6 O @G O (@) (11) (12) (13) (14) (15 (16) (17) (18)
C.
285 ] 153 177 | 140 66 |47 | 87 | 126 | 145190 | 395 | 467 393
@O O @ & @ 6 6B O @6 © (1) (11) (12 (13) (14) (15 (@16 (A7) (18
d.
285 ] 153 | 145 | 47 177 | 140 | 467 | 66 87 1126]393]90 | 395
@ O @ & @ 6 6 O G © (1wW 1) (12 @1W3) 14 (15 @) 17 1’y
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54 a. 1019
b.1021
57a. 1
b.3
c.3
d.5
e.5
f. 4
60. Hash table with 10 slots. Each slot is a bucket with 3 elements
0 1 2 3 4 5 6 7 8 9
11 90 153 145 | 66 47 | 467
140 393 285 | 126 | 87
3 395 177

62.

65.

68.

71.

Only room for the first 10 numbers. -1 used to indicate the end of a chain

0 1 2 3 4 5 6 7 8 9
Value | 87 | 90 | 126 | 140 | 153 | 145 | 66 | 47 | 177 | 285
Link | 1 3 -1 4 8 9 2 0 -1 -1

With direct chaining we need two direct access files. One file is a file of external pointers
equivalent to the array of pointers in Figure 12.28. The second file is a file of nodes. We need to
manage the memory of this second file using the techniques similar to those of the file-based linked
list discussed in Chapter 8.

Unless the integer keys being hashed are small, this technique does not make use of all of the digits
in the key. It would be better to select the four middle digits of the cube rather than the rightmost
four digits.

As long as a single bit in a group being Or "ed is one, the result is one. Or'ing a group of bits
almost always yields one. The result of Xor depends on whether the number of ones is odd or
even.
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